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1. The ______ provides access to all active applications by maintaining a
row of open application title boxes.
1. --------- खुले एप्‍लीके शन टाइटल बॉक्‍स की एक पंक्ति बनाए रखकर सभी सक्रिय
एप्लीके शन की एक्‍सेस प्रदान करता है।

*
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Serial Port

Parallel Port

CPU

motherboard

1/1

SRAM

ROM

Hard Disk

DRAM

1/1

IBM

Microsoft

Sun Microsystems

InfoSystems

2. The _______ serves as a single platform to connect all of the parts of a
computer together
2. कं म्‍प्‍यूटर के  सभी भागों को एक साथ जोड़ने के  लिए ------------ एक एकल प्‍लेटॅोर्म के
रूप में कार्य करता है ।

*

3. _______ must be continually refreshed in order to maintain the data.
3. डेटा को बनाए रखने के  लिए -------------- को लगातार रिफ्रे श होने (करने) की
आवश्‍यकता होती है।

*

4. The computer language Java was developed by ______.
4. कं म्‍प्‍यूटर भाषा जावा ( java ) को ----------- के  द्वारा विकसित किया गया था ।

*
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Processing

Kilobyte

Binary

Representational

1/1

Von-Neumann

Joseph M Jacquard

J Presper Eckert and John W Mauchly

Presper Mauchly only

1/1

kernel

shell

command

file

5. Which language do computers use to process data?
5. कं म्‍प्‍यूटर डेटा प्रोसेस करने के  लिए किस भाषा का उपयोग करते हैं ?

*

6. Who designed the first electronic computer, ENIAC?
6. पहला इलेक्‍् ट्रॉ निक कं म्‍प्‍यूटर ENIAC  किसने डिजाइन किया था?

*

7. The ______ of the UNIX system is the hub of the operating system.
7. यूनिक्‍स(unix )  सिस्‍टम का / की ------------ , ऑपरे टिंग सिस्‍टम का कें द्र(hub)  है।  

*
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Non-volatile Random Access Memory

Flash Memory

Content Addressable Memory

Sequentially Addressable Memory

1/1

Corbel

Code 93

Interleaved 2 of 5

CODE 128

1/1

to damage

to convey changes to

to add updates to

to gain access to

8. Which of the following types of computer memories is used in
applications requiring high speed searching?
8. निम्‍नलिखित में से किस प्रकार की कं म्‍प्‍यूटर मेमोरी का उपयोग उच्‍च गति से सर्च /
खोज करने वाली एप्‍लीके शन में किया जाता है ?

*

9. Which of the following is NOT a correct name of 1D Barcode font?
9. निम्‍नलिखित में से कौन सा, id बारकोड फॉन्‍ट का सही नाम नहीं  है ?

*

10. Biometric spoofing confuses the system between the artifact and the
real biological target ______ the sensitive data/materials.
10. बायोमेट्रि क स्‍पूफिं ग (biometric spoofing ) संवेदनशील डेटा/ सामग्री ---------- ,
सिस्‍टम को विरूपण शिल्‍पतथ्‍य (आर्टिफे क्‍ट) और वास्‍तविक जैविक लक्ष्‍य के  बीच भ्रमित
कर देता है।

*
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ISI

PCI

PCI express

AGP

1/1

USB 1.1

USB 2.0

USB 3.0

USB X

1/1

Windows 10 Home

Red Hat Enterprise Linux

Safari

Catalina

11. Which of the following is the latest and the fastest component of the
motherboard to support add-on cards?
11. ऐड – ऑन कार्ड को सपोर्ट करने के  लिए मदरबो् र्ड का नवीनतम और सबसे तेज
घटक इनमें से कौन सा है ?

*

12. Which of the following is the earliest version of the USB?
12. निम्‍नलिखित में कौन सा USB का सबसे पहला संस्‍करण है?

*

13. Which among the following is an application software?
13. निम्‍नलिखित में से कौन सा, एक एप्‍लीके शन सॉफ्टवेयर है?

*



1/1

10

100

20

16

1/1

digital screen

point screen

touch screen

LED Screen

1/1

E-mail spoofing

IP spoofing

Address spoofing

App spoofing

14. In contrast to binary numbers, decimal digits have ______ possible
numerals.
14. बाइनरी संख्‍याओं के  विपरीत , दशमलव अंकों में ---------- संभावित अंक होते हैं ।

*

15. Which of the following screens recognises inputs from the user
without using keyboard, mouse or any other input device?
15. निम्‍नलिखित में से कौन सा कीबोर्ड , माउस या किसी अन्‍य इनपुट डिवाइस का
उपयो् ग किए बिना उपयोगकर्ता से मिले इनपुट को पहचानती है?

*

16. ______ is a method of bypassing the security measures on a network.
16. ----------- , नेटवर्क  के  संरक्षा मानकों की उपेक्षा करने का एक तरीका है।

*
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Colour laser

Inkjet

Dot matrix

Laser

1/1

Fax

Plotter

Scanner

Synthesizer

1/1

users

installers

manufacturers

vendors

17. ______ printers are great for businesses and people who need to
produce large amounts of text documents.
17. ---------- प्रिंटर उन व्‍यवसायों और लोगों के  लिए बहुत अच्‍छे  होते हैं जिन्‍हें बड़ी मात्रा में
टेक्‍सट डॉक्‍यूमेंट छापने की आवश्‍यकता होती है।

*

18. Which of the following is a computer hardware device, much like a
printer, that is used for printing vector graphics?
18. निम्‍न में से कौन्‍ सी कं प्‍यूटर हार्डवेयर डिवाइस एक प्रिंटर की तरह दिखती है और बड़े
चित्रों को छापने के  लिए प्रयुक्‍त होती है?

*

19. PostScript Printer Description (PPD) files are created by:
19. पोस्‍टस्क्रिप्‍ट प्रिंटर डिस्क्रिप्‍शन फाइलें किसके  द्वारा क्रिएट की जाती हैं?

*
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Soft fonts

Hard fonts

Both soft fonts and hard fonts

Resident fonts

1/1

Keyboard

Plotter

Mouse

Light pen

1/1

PNG

MPEG

GIF

BMP

20. ______ for printers can be purchased from a store or downloaded from
the Internet.
20. प्रिंटर के  लिए ---------- को स्‍टोर से खरीदा या इंटरनेट से डाउनलोड किया जा सकता
है?

*

21. Which of the following is NOT an input device?
21. निम्‍न में से कौन सी एक इनपुट डिवाइस नहीं  है?

*

22. Which of the following is a compressed video file format?
22. निम्‍न में से कौन्‍ सा एक संपीडित विडियो फाइल फॉर्मेट है?

*
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many-to-many mapping

many-to-one mapping

one-to-many mapping

one-to-one mapping

1/1

MICR

OCR

Bar code reader

OMR

1/1

Transmission Control Product

Transmission Control Path

Transmission Control Protocol

Transmission Control Procedure

23. A quantiser at the encoder performs:
23. एन्‍कोडर का कांटिजर क्‍या काम करता है?

*

24. Which of the following input devices is generally used in banks as
there is a large number of cheques to be processed every day?
24. बैकों में निम्‍न में से कौन सी इनपुट का उपयोग किया जाता है, क्‍योंकि वहां प्रतिदिन
बड़ी संख्‍या में चेकों को संसाधित करना होता है?

*

25. With reference to the internet protocols, what is the full form of TCP?
25. इंटरनेट प्रोटोकॉल के  संदर्भ में , TCP का पूर्णरूप क्‍या है?

*
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Proxy server

Router

Switches

Hub

1/1

before

during

after

following

1/1

Down Size

Minimize

Maximize

Bottom Scroll

26. Which of the following provides protection between the internal
network and the internet?
26. निम्‍न में से क्‍या इंटरनेट और इंटरनल नेटवर्क  के  बीच सुरक्षा प्रदान करता है?

*

27. In a KRACK attack, the intruder performs the attack ____the WPA2
handshake.
27. क्रै क(krack) अटैक में, घुसपैठिया हमले को ,wpa2  हैंडशेक ------------- अंजाम देता
है?

*

28. Which button is used to increase the display size of the window in a
Windows OS?
28. Windows os में winsows के  डिसप्‍ले के  आकार को बड़ा करने के  लिए निम्‍न में से
किस बटन का उपयोग किया जाता है ?

*
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object file

new running process

log file

error file

1/1

three

two

single

four
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UTF-8

UTF-16

UTF-32

UTF-48

29. In case of a process failure, the operating system writes the error
report in the:
29. प्रॉसेस फे ल्‍योर मे मामले में ऑपरे टिंग सिस्‍टम ------------ में एरर रिपोर्ट लिखता है।

*

30. Commercial and industrial customers mainly use ______ phase power.
30. वाणिज्यिक और औद्योगिक ग्राहक मुख्‍यत----------- फे ज पॉवर का उपयोग करते हैं।

*

31. Which of the following is NOT a Unicode encoding system to
represent characters?
31. वणों को निरूपित करने के  लिए निम्‍नलिखित में से कौन सा एक यूनिकोड एन्‍कोडिंग
सिस्‍टम नहीं  है ?

*
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Print

Quick print

Print preview

Print layout

1/1

Internet banking

Rural banking

Urban banking

Local banking

1/1

caps lock

tab

spacebar

enter

32. Which option enables you to use a different printer or change the print
setting to print a document?
32. कौन सा विकल्‍प आपको एक अलग प्रिंटर का उपयोग करने के  लिए या कोई
डॉक्‍यूमेंट प्रिंट करने के  लिए प्रिंट सेटिंग बदलने हेतु सक्ष्‍म बनाता है ?

*

33. ______ is used to pay utility bills using banking services over the
internet.
33. ------- का उपयोग इंटरनेट पर बैंकिं ग सेवाओं का उपयोग करके  उपयोगिता
(यूटिलिटी ) बिलों का भुगतान करने के  लिए किया जाता है।

*

34. Which of the following is a Toggle key on a computer keyboard?
34. निम्‍न में से कौन सी , कं प्‍यूटर कीबोर्ड पर एक टॉगल की है?

*
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Electronic trading

Electronic services

Electronic goods

Electronic products

1/1

b, a, d, c

b, a, c, d

b, d, a, c

b, c, d, a

35. _________ is a method of electronically exchanging securities (such as
stocks and bonds), foreign exchange or financial derivatives.
35. -------------- , प्रतिभूतियॉ ( securities ) (जैसे की स्‍टॉक और बॉन्‍ड ) , विदेशी मुद्रा
वितनमय या वित्तीय डेरिवेटिव का इलेक्‍ट्रा निक रूप से आदान प्रदान करने की एक विधि
है।

*

36. Following are the set of steps to turn off the automatic capitalisation
feature in MS-Word. Arrange the steps in the correct order.
36. Ms word में स्‍वचलित कै पिटलाइजेशन के  फीचर (automatic capitalisation
feature) को बंद करने के  लिए चरणों का सेट निम्‍नलिखित है। चरणों को सही क्रम में
व्‍यवस्थित करें  ।
a) Make sure the AutoCorrect tab is displayed.
b) Choose AutoCorrect Options from the Tools menu. Word displays the
AutoCorrect dialog box.
c) Click on OK.
d) Clear the Capitalize first letter of sentences

*
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Normal

Moderate

Narrow

Mirrored

1/1

Horizontal and vertical

Top and bottom

Left and right

Horizontal and right

1/1

First line option

Hanging option

Right indent option

none option

37. Which margin style gives 0.5 inch empty space on all sides of the
page in an MS-Word document?
37. Ms word डॉक्‍यूमेंट में पेज के  सभी किनारों पर कौन सी मार्जिन स्‍टाइल 0.5 इंच का
रिक्त स्‍थान (empty space) देती है।

*

38. ______ rulers help you align text, graphics, tables and other elements
in your document.
38. ----------- रूलर आपको अपने डॉक्‍युमेंट में टेक्‍स्‍ट, ग्राफिक्‍स , तालिकाओं और अन्‍य
तत्‍वों को संरे खित करने में सहायता करती है।

*

39. Which of the following options is NOT available in the drop down
menu of the Special option in Indentation control in the Paragraph tab?
39. पैराग्राफ टैब में इंडेंटेशन नियंत्रण ( imdentation control ) के  विशेष विकल्‍प
(special option) के  ड्रॉ प मेनू में निम्‍न में से कौन सा विकल्‍प उपलब्‍ध नहीं  है ?

*
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It replace all instances of the specified text.

It gives advanced search options

It finds more instances of the specified text.

It expands the Find and Replace dialog box.

1/1

single line

bold single line

double line

heavy dotted line

1/1

Keyboard

Mouse

Scanner

Printer

40. What happens when you click the 'more' button in the Find and
Replace dialog box of MS-Word 2010?
40. जब आप ms word 2010 के  फाइंड और रिप्‍लेस (find and replace) डायलॉग
बॉक्‍स में ‘more’ बटन पर क्लिक करेंगे तो क्या होगा ?

*

41. In a MS-Word document, when you type three asterisks and then
press enter key, you get a ______.
41. एक ms word डॉक्‍यूमेंट में , जब आप तीन तारांकन ( asterisks) टाइप करते हैं
और एं टर कुं जी दबाते है , तो आपको एक ------------ मिलती है।

*

42. Which of the following is NOT an input device?
42. निम्‍नलिखित में से कौन सा , एक इनपुट डिवाइस नहीं  है?

*
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16

61

100

101

1/1

Cannot insert tables with columns and rows

Cannot insert pictures, clipart and shapes

Cannot edit the text in the body of the document while you are editing the
header or footer

No automatic page numbers

1/1

a single

double

triple

many

43. What is the hexadecimal equivalent of (257)10?
43. (257)10 संख्‍या का हेक्‍साडेसिमल समकक्ष क्‍या है?

*

44. Which of the following is true about Header and Footer in a MS-Word
document? (Select the most appropriate among the following.)
44. Ms word डॉक्‍यूमेंट में शीर्ष्‍ लेख ( हेडर) और पाद लेख ( फु टर ) के  बारे  में
निम्‍नलिखित में से कौन सा सत्‍य है ?(निम्‍नलिखित में से सबसे उपयुक्‍त का चयन करें।)

*

45. The Directory feature in MS-Word creates _______ document(s)
containing a catalogue or printed list of addresses in mail merge.
45. Ms word  में डायरेक्‍टारी  फीचर ----------- डॉक्‍यूमेंट बनाती है जिसमें मेल मर्ज (
mail merge) में एड्रे स की कै टेलॉग सूची या प्रिंटेड सूची होती है।

*
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move the cursor one word right

moves the cursor end to the line

moves the cursor end of the document

moves the cursor one Paragraph down

1/1

colour the document

save the document

delete the document

print the document

1/1

Alt + F12

Ctrl + F12

Shift + F12

F12

46. Ctrl + Right Arrow is a keyboard shortcut used to -
46. Ctrl + right arrow एक कीबोर्ड शॉर्टकट है जिसका प्रयोग किसके  लिए किया जाता
है?

*

47. Using print preview is useful when you want to ______________.
47. प्रिंट प्रीव्‍यू को उपयोग करना उपयोगी होता है जब आप -------- चाहते हैं।

*

48. Which is/are the shortcut key(s) to open the Open dialog box in
Microsoft Project Professional?
48. Microsoft project professional में ओपन डायलॉग बॉक्स खोलने के  लिए
शॉर्टकट कुं जी कौन सी है ?

*
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orientation

breaks

font style

font size

1/1

File -> Save only

File -> Save As -> Choose File Type

Shift + S only

Alt + S only

1/1

Percentages and fractions

Chemical formulae

Service mark SM and trademark TM

Exponential Equations

49. The page layout affects how content appears and includes the page's
_______, margins and size.
49. पेज लेआउट इस बात को प्रभावित करता है कि कं टेंट कै सा दिखाई देता हैं और
इसमें पेज का ------------ , मार्जिन और आकार शामिल होता है।

*

50. How can you save a document in a different format in MS-Word?
50. Ms word में अलग फार्मेट में डॉक्‍यूमेंट कै से सेव किया जाता है?

*

51. Which of the following is an example of subscripts that are dropped
below the baseline?
51. निम्‍न में से सबस्क्रिप्‍ट का कौन सा उदाहरण है जो बेसलाइन के  नीचे रखा गया है?

*
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FTP

SMTP

POP

IMAP

This content is neither created nor endorsed by Google. - Terms of Service - Privacy Policy

Does this form look suspicious? Report

52. ______ is one of the simplest and easiest ways to exchange files
between one or more computers on the Internet.
52. इंटरनेट पर एक या अधिक कं प्‍यूटरों के  बीच फाइलें विनिमय करने का सबसे आसान
तरीका ------------ है।

*
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